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UM0894
User manual

STM32W-SK and STM32W-EXT starter and extension kits
for STM32W108xx microcontrollers

Introduction
The STM32W-SK and STM32W-EXT starter and extension kits are easy to use tools for the 
STM32W108xx microcontrollers. This family of microcontrollers integrates a 32-bit ARM® 
Cortex™-M3 microprocessor and a 2.4 GHz, IEEE 802.15.4-compliant transceiver. The kits 
demonstrate how effectively the STM32W108xx can be used in real IEEE 802.15.4 
applications. They are suitable for different types of wireless network scenarios such as:

● Mesh networks (based on the ZigBee PRO protocol stack) typically used in home 
automation and smart energy applications.

● Remote control and target networks (based on the ZigBee RF4CE protocol stack) used 
for driving consumer devices such as TVs, set-top boxes, etc.

● Point to point networks (based on a Simplified MAC library) used to address a basic 
IEEE 802.15.4 communication. This configuration enables customers to develop any 
protocol stack of their choice.

The STM32W108xx kits provide demonstration applications and documentation which serve 
as a reference for creating your own applications and re-programming the STM32W108xx 
microcontroller. You can run the STM32W108xx kits in several ways (building mesh 
networks, remote control/target and point-to-point applications), using the dedicated 
software libraries (ZigBee PRO, ZigBee RF4CE, and Simplified MAC), as well as a third-
party IDE and C compiler (IAR).

Moreover, the STM32W108xx kits provide a set of HAL APIs which allow you to use the kit 
platform capabilities such as LEDs and serial communication channels (virtual COM 
through USB).

In this manual, you can find information about:

● The STM32W108xx kits components

● How to install the related hardware, software and documentation trees

● How to run the preprogrammed demonstration applications.

Note: 1 The term “application board” refers to the MB851 and MB954 platforms.

2 For more information, visit the STM32W 32-bit RF microcontroller webpages at 
www.st.com/stm32w

This web page provides full access to all the STM32W108xx resources (kits, software 
packages and documents).

www.st.com
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1 Getting started

This section provides a complete description of the STM32W-SK and STM32W-EXT kit’s 
hardware and software.

There are two types of STM32W108xx kit:

● The starter kit (order code: STM32W108B-SK)

● The extension kit (order code: STM32W108B-KEXT)

1.1 Kit description

1.1.1 Hardware

STM32W-SK

The STM32W108xx starter kit package contains the following hardware components: 

● Two STM32W108 application boards (MB851) 

● One STM32W108 extension board (MB850)

● One Raisonance STM32-Primer2 tool (STM3210E-PRIMER)

● One J-Link Lite JTAG Flash programmer and debugger

● One mini USB cable

● Four AAA batteries

Figure 1. STM32W-SK starter kit

Network Analyzer (Perytons)

J-Link Lite +
IAR compiler

MB850 
extension board

+
STM32-Primer2

MB851 application board x2

Downloaded from Elcodis.com electronic components distributor 

http://elcodis.com/


UM0894 Getting started

Doc ID 16999 Rev 4 7/36

STM32W-EXT

The extension kit package contains two STM32W108 application boards (MB851) and two 
STM32W108 application boards with a power amplifier (MB954).

          

Note: 1 For documentation concerning the STM32-Primer2 tool, refer to the related user manual on 
the http://www.stm32circle.com website.

2 For information concerning the STM32W108xx application boards, refer to the 
documentation with each available software and documentation tree installer file (see 
Section 1.7: Software libraries and demonstration applications).

1.2 MB850 hardware description

1.2.1 MB850 resources

None 

1.2.2 MB850 connectors

The following table lists the connectors available in the MB850 board and their 
functionalities.

          

Figure 2. MB851 application board Figure 3. MB954 with Power Amplifier 
application board

                    

Table 1. MB850 connectors
Type Label Function

Header 6H JP1 SWD debug

Header 10X2 JP2 Connector to Primer2 board
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1.2.3 MB850 connectors: JP1 pins
          

1.2.4 MB850 Connectors: JP2 pins
          

1.2.5 MB850 jumper configuration

None

Table 2. MB850 connectors: JP1 pins

Pin number GPIO/ Function

1 +2V8

2 GND

3 PC0/JRST

4 SWCLK/JTCK

5 PC4/SWDIO/JTMS

6 nRST

Table 3. MB850 Connectors: JP2 pins

Pin number GPIO/ Function

1 +2V8

2 GND

3 NC

4 NC

5 PA0

6 PA1

7 PA2

8 PA3

9 NC

10 NC

11 nRST

12 PA5

13 NC

14 PB4

15 PB3

16 PB2

17 NC

18 PB1

19 NC

20 GND
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1.2.6 MB850 PC interface chip

None

1.2.7 MB850 battery holder

None

1.3 MB851 hardware description

1.3.1 MB851 resources

The following table lists the resources available in the MB851 board to develop applications 
and their connection with STM32W108 pins.

          

1.3.2 MB851 connectors

The following table lists the connectors available in the MB851 board and their 
functionalities.

          

Table 4. MB851 resources

Type Label Part
Rev A Rev B Rev C

STM32W108 pin

Button RST1

Button S1 PA7 PA7 PB3

I²C EEPROM U4
M24C64MW1

128KBytes
NA NA PA1, PA2

Led D1 PB6 PB6 PA5

Led D3 PB5 PB5 PA0

Led D5 Infrared led PB4 PB4 PB4

Mems U2 LIS302 PA1, PA2 PA1, PA2 PA1, PA2

Temperature 
Sensor

U3 STLM20 PB7 PB7 PA4

Table 5. MB851 connectors

Type Label Function

Mini USB J2 PC I/O

Header, 14-pin, Dual row male P1 GPIO access

Header, 10-pin, dual raw male P4 Standard JTAG debug
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1.3.3 MB851 connectors: P1 pins
          

Table 6. MB851 connectors: P1 pins 

Pin number GPIO function

1 +VBRD

2 PC5

3 nRST

4 PA7

5 PB3

6 PB4

7 PA0

8 PA1

9 PA2

10 PA4

11 PA3

12 PA6

13 PA5

14 GND

15 PB1

16 PB2

17 JTCK

18 PC2

19 PC3

20 PC4

21 GND

22 GND

23 PB0

24 PC1

25 PC0

26 PB7

27 PB6

28 PB5
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1.3.4 MB851 connectors: P4 pins
          

1.3.5 MB851 jumper configuration

The following table lists the jumpers configurations on the MB851 board. 

          

Table 7. MB851 connectors: P4 pins

Pin number GPIO function

1 +VBRD

2 +VBRD

3 PC0

4 GND

5 PC3

6 GND

7 PC4

8 GND

9 JTCK

10 GND

11 GND

12 GND

13 PC2

14 GND

15 nRST

16 GND

17 GND

18 GND

19 +VJTAG

20 GND

Table 8. MB851 jumper configuration

Label Configuration

JP1
Power  Mems and Temperature sensor and 

infrared led

P2

1-2: battery powered

2-3: reserved

3-4: USB or  JTAG powered
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1.3.6 MB851 PC interface chip

The following table lists the PC interface chip available in the MB851 board to allow I/O 
interface to the  STM32W108.

          

1.3.7 MB851 battery holder
          

1.4 MB954 hardware description

1.4.1 MB954 resources

The following table lists the resources available in the MB954 board to develop applications 
and their connection with STM32W108 pins.

          

1.4.2 MB954 connectors

The following table lists the connectors available in the MB954 board and their 
functionalities.

Table 9. MB851 PC Interface chip

Revision Type Part

Rev. A PC I/O FTDI FT232R

Rev. B PC I/O FTDI FT232R

Rev. C PC I/O STM32F103TBU6

Table 10. MB851 battery holder

Type Label

2x AAA battery holder BT1

Table 11. MB954 resources 

Rev. A Rev. B

Type Label Part GPIO GPIO

Button RST1

Button S1 PB3 PB3

I²C EEPROM U4
M24C64MW1

128 KBytes
Not fitted PA2

Led PA5 PA5

Led D3 PA0 PA0

Led D5 Infrared led PB4 PB4

Mems U2 LIS302 PA1, PA2 PA1, PA2

Temperature Sensor U3 STLM20 PA4 PA4
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1.4.3 MB954 Connectors: P1 pins
          

Table 12. MB954 connectors

Type Label Function

Mini USB J2 PC I/O

Header, 14-pin, Dual row male P1 GPIO access

Debug Connector P4 Standard JTAG debug

Table 13. MB954 connectors: P1 pins 

Name GPIO function

1 +VBRD

2 PC5

3 nRST

4 PA7

5 PB3

6 PB4

7 PA0

8 PA1

9 PA2

10 PA4

11 PA3

12 PA6

13 PA5

14 GND

15 PB1

16 PB2

17 JTCK

18 PC2

19 PC3

20 PC4

21 GND

22 GND

23 PB0

24 PC1

25 PC0

26 PB7
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1.4.4 MB954 Connectors: P4 pins
          

1.4.5 MB954 jumper configuration

The following table lists the jumpers configurations  in the MB954 board.

          

27 PB6

28 PB5

Table 13. MB954 connectors: P1 pins (continued)

Name GPIO function

Table 14. MB954 connectors: P1 pins 

Name GPIO function

1 +VBRD

2 +VBRD

3 PC0

4 GND

5 PC3

6 GND

7 PC4

8 GND

9 JTCK

10 GND

11 GND

12 GND

13 PC2

14 GND

15 nRST

16 GND

17 GND

18 GND

19 +VJTAG

20 GND

Table 15. MB954 jumper configuration

Label Configuration

JP1
Power Mems and temperature sensor and 

infrared LED

Downloaded from Elcodis.com electronic components distributor 

http://elcodis.com/


UM0894 Getting started

Doc ID 16999 Rev 4 15/36

1.4.6 MB954 PC interface chip

The following table lists the PC interface chip available in the MB954 board to allow I/O 
interface to the  STM32W108.

          

1.4.7 MB954 battery holder
          

1.5 Software

STM32W-SK

The starter kit package contains the following software components:

● One CD-ROM including PerytonsTM network analyzer (V3.05 or later).

● One CD-ROM including the IARTM Limited 30-days Evaluation Compiler 5.40.7 or later.

● One CD-ROM including the RaisonanceTM Development Suite for the STM32-Primer2.

STM32W-EXT

No CDs are delivered with the extension kit package.

1.6 Documentation
The starter kit package STM32W-SK contains the following documentation components: 

● STM32W108 starter kit welcome letter which briefly describes the kits targets and 
components.

● Raisonance STM32-Primer2 welcome letter.

The extension kit package STM32W-EXT contains an STM32W108 extension kit welcome 
letter which briefly describes the kits targets and components.

P2

1-2: battery powered

2-3: reserved

3-4: USB or  JTAG powered

Table 15. MB954 jumper configuration

Label Configuration

Table 16. MB954 PC interface chip

Revision Type Part

Rev. A PC I/O FTDI FT232R

Rev. B PC I/O STM32F103TBU6

Table 17. MB954 battery holder

Type Part

2x AAA battery holder BT1
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1.7 Software libraries and demonstration applications
The following installer files are available on the STM32W 32-bit RF microcontroller 
webpages at www.st.com/stm32w:

● EmberZNet-4.3.0.0-STM32W108: installer file which provides the EmberZNet™ 4.3.0 
GA software libraries and demonstration applications targeting the mesh network 
scenarios based on the ZigBee PRO protocol stack.

● ST ZigBee RF4CE-1.2.0.0-STM32W108: installer file which provides the STM32W108 
ZigBee RF4CE software library and demonstration applications for controlling an 
RF4CE compliant TV using an RF4CE compliant remote control.

● ST Simple MAC- 1.0.3.0-STM32W108: installer file which provides the STM32W108 
Simple MAC software library and demonstration applications targeting point-to-point 
communication scenarios based on the IEEE 802.15.4 protocol. 

For a detailed description of each software and documentation tree, refer to the related 
documentation (starting from the HTML index file, that comes with each installer file).

Note: Each installer file also provides a set of prebuilt binary images (applications and utilities). 
Please check for the most recent installer file versions on the STM32W 32-bit RF MCUs 
Internet webpages at www.st.com/stm32w
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1.8 Kit setup

1.8.1 Powering on the boards

Each application board can be powered as follows: 
● Via batteries (fit 1-2 on the P2 jumper) 
● Via USB or JTAG (fit 5-6 on the P2 jumper) 

Note: 1 The jumper position 3-4 is reserved for internal usage.

2 To enable the application board temperature, MEMS and infrared sensors, fit jumper JP1.

The MB850 extension board is designed as an IEEE 802.15.4 application-specific 
daughterboard. It must be connected to the STM32-Primer2 extension connector to be 
powered through the STM32-Primer2. The MB850 should be connected with the 
STM32W108 visible. 

1.8.2 Installing drivers for USB virtual COM 

In order to use the serial communication channel on an application board, a driver for the 
FTDI USB<-> Serial converter or a Virtual COM port driver for an STM32F103xx must be 
installed. The correct driver to install is based on the application board revision number. 

The following application boards requires the driver FTDI USB<-> Serial converter: 
● MB851 Rev A
● MB851 Rev B
● MB954 Rev A

The related drivers can be downloaded from the FTDI website at www.ftdichip.com/Drivers/
D2XX.htm

All other application boards require the STMicroelectronics Virtual COM port driver which 
can be directly downloaded from www.st.com/internet/com/SOFTWARE_RESOURCES/
SW_COMPONENT/SW_DRIVER/vcpdriver_v1.zip

1.8.3 Setting up the application serial communication channel 

To get full access to all the available commands, some demonstration applications may 
require that the application board is interfaced with the user through a serial communication 
channel (virtual COM through USB). To set a serial communication channel for the 
application board, follow these steps:

1. Fit the application board jumper P2 on position 5-6 (power via USB).

2. Connect a mini USB cable to the application board mini-USB connector and to a PC 
USB port.

3. Right-click on My Computer, select Manage, Device Manager, and open Ports (COM 
& LPT) to display the related USB COMx port.

4. Open a hyper terminal on the corresponding USB virtual COMx port with the following 
configuration:
– Bit rate: 115200
– Data bits: 8
– Parity: None
– Stop bits: 1
– Flow control: None

The STM32-Primer2 and MB850 demonstration applications use the STM32-Primer2 
resources (LCD, joystick with button, touch screen display) as I/O communication channels.
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2 Running the STM32W108xx kits 

STM32W-SK

In the STM32W-SK starter kit, the following applications are preprogrammed: 

● One EmberZNet ZigBee PRO sink firmware (MB850 board labeled as “Sink”)

● Three CircleOs applications preloaded in the STM32-Primer2:

– ZigBee PRO sink application

– ZigBee RF4CE RC application

– Simple MAC sun sample application 

● One EmberZNet ZigBee PRO sensor firmware (application board labeled as “Sensor”) 

● One Perytons capture firmware (application board labeled as “Analyzer”)

This allows you to immediately run the ZigBee PRO sink, sensor demonstration 
applications, just by selecting the sink application on the STM32-Primer2 (see Section 2.2: 
Sink, sensor mesh network (based on ZigBee PRO) for more details). You can also start a 
packet capture session using the Perytons analyzer (see Section 3.2: Network analyzer for 
more details).

STM32W-EXT

In the STM32W-EXT extension kit, all four boards are preprogrammed with EmberZNet 
ZigBee PRO sensor firmware (application board labeled as “Sensor”). 

Using these boards, you can extend the sink, sensor mesh network with other four sensor 
nodes.

2.1 Installing the STM32W108xx kit software tree
To install the specific kit software and documentation tree, download the related installer file 
from the STM32W 32-bit RF MCUs Internet web pages. Then start the installation process 
on your destination folder.

2.2 Sink, sensor mesh network (based on ZigBee PRO)
This section shows how to set up a mesh network with a ‘sink’ node which collects 
information that come from several ‘sensor’ nodes.

2.2.1 Run preloaded sink appl. on STM32-Primer2, MB850 platforms

The STM32-Primer2 tool is delivered with the sink application preloaded. This application 
automatically configures the connected MB850 extension board with the related ZigBee 
PRO sink application. 

To run the sink application on the STM32 Primer2 and MB850 boards, follow these steps:

1. Connect the MB850 to the extension connector of the STM32-Primer2 tool.

2. Power on your STM32-Primer2.

3. Press the joystick button to launch the main menu and select Applic.->ZP SINK.
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If everything is done properly, you get an LCD screen showing a light blue box in the center 
(see Figure 4). This box represents the sink node (a ZigBee PRO network has been 
created).

Figure 4. STM32-Primer2 sink node

4. To access the application main menu, press the button again. This is the first level 
option list. Options can be classified in two categories:

– Options that give information about the sink node (node address, security key, 
address table, child table …).

– Options that execute specific commands (send custom messages, permit join, 
leave network, reset, quit).

2.2.2 Run preloaded sensor application on the application board

To run the sensor application on the kit application board, follow these steps:

1. Power on the application board already preloaded with the sensor application (labeled 
as sensor).

2. If you want to access to the full set of the available commands on the sensor node, you 
have to set up the related serial communication channel, following the steps described 
in Section 1.8.3: Setting up the application serial communication channel.

3. Once the sensor application is running, type ’?’ on the related hyperterminal to get the 
list of available supported commands.

Note: A prebuilt sensor binary image is also available. To download it, just use the stm32w_flasher 
utility (refer to Section 3.1: stm32w_flasher utility).

2.2.3 Setup a sink, sensor mesh network 

To set up a sink, sensor mesh network, from the STM32-Primer2 sink main menu, select 
Permit join and press the S1 button on the application board sensor.

Once the sensor is joined to the network formed by the sink, the sensor node is displayed on 
the STM32-Primer2 LCD as a green box with the related 2-byte short address underneath. 
Furthermore, the application board LEDs start blinking.

Figure 5. Sensor joined to the sink
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When the sensor sends data to the sink, a blue line connecting the transmitting sensor to 
the sink is displayed on the screen. The unicast data sent by the sensor node is a 
temperature value coming from its temperature sensor.

Figure 6. Sensor sends unicast data to the sink

This allows you to identify which sensor is transmitting data if there is more than one sensor 
(up to 5 supported by the STM32-Primer2 sink application).

Note: The unicast data sent by the sleepy or mobile sensors are 2 bytes random data.

Figure 7. Sink + 5 sensors (including sleepy, mobile sensors)

The following table groups the symbols appearing on the STM32-Primer2’s LCD screen and 
the associated events:

          

Table 18. Definition of LCD screen symbols (ZigBee PRO sink application) 

Symbol Associated event

Blue line connecting two nodes Unicast data transmission (see Figure 6)

5 orange lines arranged in a star-like shape Multicast data transmission (see Figure 8)

! Error condition (see Figure 9)

D Network down (see Figure 10)

Gray box Sleepy sensor 

Purple box Mobile sensor
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Figure 8. Sink sends an advertise (multicast message)

Figure 9. Network error on sink node

Figure 10. Network down

Note: For further information about the STM32-Primer2, MB850 sink application and related 
limitations, refer to the installer file documentation.

2.3 Remote control and virtual TV (based on RF4CE library)
This section shows how to control a ZigBee RF4CE-compliant TV target using an RF4CE-
compliant remote control. The demonstration application is run using the STM32-Primer2 
and MB850 as a remote control and a PC applet for emulating a TV on your PC.

The RF4CETV PC applet implements a virtual TV supporting the following features:

● 12 channels, playing video from files

● Volume control

● Mute

● Channel change

● Play/Pause

● Pair button

● Device information
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2.3.1 Run the remote control (RC) and virtual TV applications

The STM32-Primer2 tool provided with the STM32W-SK starter kit is delivered with the RC 
application. This application automatically configures the connected MB850 extension board 
with the related ZigBee RF4CE RC application. 

The application board is automatically configured when launching the RF4CETV PC applet.

To run the RC and TV applications on the STM32 Primer2, MB850 and application board 
platforms, the following steps are required:

1. Connect the MB850 to the extension connector of the STM32-Primer2 tool.

2. Power on your STM32-Primer2.

3. Press the joystick button to launch the Main Menu and select Applic.->RF4CE RC.

If everything is properly done, the LCD screen displays a set of RF4CE RC commands.

4. Connect the application board to the PC using a mini USB cable with P2 fitted in 
position 5-6 (power from USB). A virtual COM port should appear in the Windows 
Device Manager.

5. From Windows, launch the RF4CETV.exe PC applet. A PC applet GUI appears.

6. Select the serial port matching the port assigned by the Windows Device Manager. If 
the firmware on the application board is not present, the application uploads the 
firmware through the serial port. Wait until the LED D1 is on.

7. Push the button to start pairing with the RF4CE remote control. LED D1 starts 
blinking quickly when the node is ready for pairing (for 30 sec.).

8. On your STM32-Primer2, use the joystick to scroll between button pages until you find 
the button . Push the button to start pairing with the application board.

If everything is properly done, a message on your STM32-Primer2 screen and in the 
RF4CETV applet informs you that the pairing process has been successful.

Figure 11. RF4CETV PC applet
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2.3.2 Use the remote control (RC) and virtual TV applications

To send an RC command to the virtual TV, push the associated RC symbol on the STM32-
Primer2 touch sensing screen.

Figure 12. RF4CE RC application driving the ST Virtual TV PC applet

Note: For further information about the ST RF4CE demonstration applications, refer to the 
STM32W108xx ZigBee RF4CE library user manual (UM0909).

2.4 Basic star network (based on Simple MAC library)
This section shows how to set up a star network supporting parent and child roles (called 
respectively; sun and planet).

2.4.1 Run preloaded sample appl. on STM32-Primer2, MB850 platforms

The STM32-Primer2 tool provided with the STM32W-SK starter kit is delivered with a 
sample application (sun image). This application automatically configures the connected 
MB850 extension board with the related sample application.

To run the sample application on the STM32-Primer2, MB850 platforms, follow these steps:

1. Connect the MB850 to the extension connector of the STM32-Primer2 tool.

2. Power on your STM32-Primer2.

3. Press the joystick button to launch the main menu and select Applic.->SM SUN.  
If everything is done properly, you get an LCD screen showing a light blue box in the 
center. This blue box represents the sun node (a network has been created).

Figure 13. STM32-Primer2 sun node
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4. Press the button again to access the application main menu. This is the first level 
option list. Options can be classified in two categories:

– Options that provide information about the sun parameters (node information, 
planets list)

– Options that execute actions (leave network, quit)

Note: For further information about the STM32-Primer2, MB850 sun application and related 
limitations, refer to the documentation that comes with the installer file.

2.4.2 Run the prebuilt sample planet application on the application board

To download and run the prebuilt sample planet application on an application board, use the 
stm32w_flasher utility with the prebuilt sample_planet.s37 binary file. 

Refer to Section 3.1: stm32w_flasher utility for more details.

2.4.3 Setup a star network 

On the planet node, press button S1 to join the network formed by the STM32-Primer2 sun 
node. Once joined, the planet LED D3 turns on and the planet node is displayed on the 
STM32-Primer2’s LCD (as a green box with the related 2-byte short address underneath). 

Figure 14. Planet device joined to the network

When a planet device sends data to the sun device (at periodic rate), a blue line connecting 
the transmitting planet to the sun is displayed on the screen as well as the sent application 
board VDD_PADS value (in mV).

Figure 15. Planet sends data to the sun

This identifies which planet is in transmission mode if there is more than one planet device 
(up to 5 supported by the STM32-Primer2 sun application). 
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Figure 16. Sun node with 5 planets

Figure 17. Network down 

The following table summarizes the symbols appearing on the LCD screen and the 
associated events.

          

Note: For further information about the Simple MAC sample application, refer to the installer file 
documentation (in particular, STM32W108xx Simple MAC user manual - UM0893).

Table 19. Definition of LCD screen symbols (Simple MAC sample application)

Symbol Associated event

Blue line connecting planet to sun Planet sends data to the sun (see Figure 15)

D Network down (see Figure 17)
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3 STM32W108xx kits utilities and software tools

3.1 stm32w_flasher utility
The stm32w_flasher utility allows you to download a binary file into the STM32W108xx 
application board. This utility comes with each software installer file. To download a binary 
image, follow these steps:

1. Fit the application board jumper P2 on position 5-6 (power via USB).

2. Connect a mini USB cable to the application board mini-USB connector and to a PC 
USB port.

3. Using the mouse, right-click on My Computer, select Manage, Device Manager, and 
open Ports (COM & LPT) to display the related USB COMx port. 

4. Open an DOS Window on your PC.

5. Go to the utilities folder which comes after the installation process.

6. Type the following command: stm32w_flasher –p <COMx> -r –f <file_name.bin/.s37>

where COMx is the virtual COM related to the connected application board, and 
file_name.bin/.s37 is the application image to be downloaded.

Note: You can also use the stm32w_flasher utility through the JTAG programmer:

1. Fit the application board jumper P2 on position 5-6 (power via JTAG). 
2. Plug the JTAG programmer to a PC USB port and to the board JTAG connector P4. 
3. Open an DOS Window on your PC. 
4. Go to the folder where the stm32w_flasher is located (tool or utility folder). 
5. Type the following command: stm32w_flasher -f <file_name.bin/.s37> -r

3.2 Network analyzer

3.2.1 Perytons

To install the Perytons network analyzer, insert the related CD-ROM and follow the 
installation instructions. To use the Perytons network analyzer, follow these steps:

1. Application board labeled as “Analyzer“: fit jumper P2 on position 5-6 (power via USB) 
and connect to a PC USB port.

2. Open the Perytons tool (from Start, Programs).

3. For instructions about how to start a packet capture session refer to the documentation 
on the Perytons CD-ROM.

When a packet capture session is ongoing, the application board LEDs behave as follows:

● When data is sent to the PC LED D1 flashes for a short period.

● LED D3 is the heartbeat LED

A prebuilt analyzer binary image for Perytons is provided with each installer file.
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3.3 IAR Embedded Workbench® for ARM
To install the IAR Embedded Workbench® for ARM 5.40.7 or later, follow these steps:

1. Go to the Download section of the IAR website (www.iar.com) download section and 
select a 30-day IAR version for ARM.

2. Start the download procedure and receive a 30-day license.

3. Insert the STM32W108 Starter Kit IAR CD-ROM (IAR 5.40.7) and follow the installation 
instructions using the 30-day licence from the IAR website.

To build the binary image of all the available demonstration applications using the IAR tool, 
follow these steps:

1. Open the IAR tool.

2. From the File > Open > Workspace menu, open the *.eww IAR project related to the 
demonstration application you are going to address.

3. From the Project menu, select Rebuild All. A binary file is built under the project folder 
specified in Project > Options > General Options Category > Output menu > 
Executables/libraries item.

To download the built binary image on the application board, follow these steps:

1. Connect the JTAG Flash programmer to the application board P4 connector and to a 
PC USB port (through an USB cable).

2. Power the application board through the JTAG: P2 jumper fitted on 5-6 position.

3. From the Project menu, select Download and Debug. The binary image is downloaded 
into the STM32W108xx Flash.

4. From the Project menu, select Stop Debugging. The application is ready to run.

Note: To use the J-Link Lite JTAG Flash programmer, you need to switch on the “power supply for 
target” feature. The first time you plug the J-Link Lite on a PC USB port, follow these steps 
(make sure that you have already installed the IAR Embedded Workbench 5.40.7 or later):

1. Open an DOS Window on your PC.

2. Type jlink.

3. Issue the command: power on perm.
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4 List of acronyms

          

Table 20. List of acronyms used in the document

Term Meaning

API Application programming interfaces

CERC Consumer electronic remote control

GA General availability

HA Home automation

HAL Hardware abstraction layer

MAC Medium access control

PA Power amplifier

RC Remote control

RF Radio frequency communication

SE Smart energy

USB Universal serial bus
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5 Available board schematics

Figure 18. MB850 Rev.A
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Figure 19. MB851 module
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Figure 20. MB851 Rev.A
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Figure 21. MB851 Rev.B
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Figure 22. MB954 module
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Figure 23. MB954 Rev.A
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6 Revision history

Table 21. Document revision history

Date Revision Changes

05-Feb-2010 1 Initial release.

21-Apr-2010 2

Modified software component versions in Section 1.5.
Modified installer files in Section 1.7.

Modified Parity to 1 in Section 1.8.3.

Modified Section 2.2.2, Section 2.2.3, Section 2.4.3.
Inserted Section 3.4.

08-Feb-2011 3
Added reference to MB954 application board with power amplifier (PA) 
delivered with latest generation of the STM32W108xx extension kit.

21-Jun-2011 4

Added Section 5: Available board schematics

Changed Figure 2: MB851 application board and Figure 3: MB954 
with Power Amplifier application board
Added Section 1.2: MB850 hardware description

Added Section 1.3: MB851 hardware description

Added Section 1.4: MB954 hardware description
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